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 Introduction to Basic Electrical Tools 
 

Objective: 

The objective of the experiment is to learn about the commonly used equipment used in the lab and how to 

properly use it. 

Breadboard 

Breadboard is a board used for electrical circuit prototyping. Before the circuit is permanently placed in a 

PCB (Printed Circuit Board) prototyping boards are used to verify the electrical circuit. Some other 

prototyping boards are: Perfboard, Stripboard, Veroboard etc. 

Top two row (A and B) of the board are internally connected sideways and the holes in group B are 

connected vertically as show in the figure 1 and this sequence continue in the rest of the board. 

  
Figure 1.1: External and Internal construction of the breadboard  

 

From circuit to Breadboard: 

Closely observe the circuit diagram (electronic schematic) and the equivalent connection on breadboard.  

3V 2.2KΩ 

1KΩ 
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Figure 1.2: Circuit diagram and the equivalent breadboard connection  

DC Power Supply: 

In the Lab we have two DC source in the workbench. One can be found in the trainer board Fig 1.3(a) and 

another is a individual DC power supply module Fig 1.3(b).  

DC Power Supply

+V

+5

GND

-5

-VMin Max
-V

Min Max
+V

 

5.20 
V

.1

A

Voltage

FINE COARSE

Current

FINE COARSE

Power

C.C. C.V.

GND +-

 
(a) Trainer board DC source (b) DC power supply module 

Figure 1.3: DC power sources 
 

Trainer board DC source: 

Trainer board DC power supply can deliver two variable and two fixed DC voltage at the same time. The 

variable voltage can be adjusted using the two dial. 

Voltage output at pin 
(reference to GND) 

Value Type 

+V 1.2 V to 20 V Variable 

+5 5 V Fixed 

-5 -5 V Fixed 

-V -1.2 V to  -20V Variable 

 

DC power supply module: 

The DC power supply module can deliver voltage ranging from 0V to 30V.  

1. To set a particular voltage turn on the power supply. 

2. To change the voltage in big step use the coarse dial and to precisely vary the voltage use the fine 

dial in the voltage group. 

3. Observe the output voltage change. 

The coarse and  fine dial in current group is used to set the maximum current limit at the output. 
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Measuring Voltage: 

1. To measure the voltage across the 1KΩ resistor circuit in Fig 1.4 (a), construct the circuit as shown in 

Fig 1.4 (b). 

2. Rotate the multimeater dial in the V position. 

3. Connect the red and black multimeater lead as shown in the Fig 1.4(a) (parallel to the resistor) 

4. Multimeater should display the Voltage 

Warning: while measuring voltage multimeater dial SHOULD NOT be in mA (current) position. It might 

destroy/damage the meter   

+  

V   
         
-

5V 2.2KΩ 

1KΩ 

 5V 2.2KΩ 

+

V

-

5.000 
AUTO

V

Red wire Black Wire

Off

Ω 

Hz

mA

1KΩ 

 
(a) (b) 

Figure 1.4: Circuit diagram and actual connection for measuring voltage 
 

Measuring Current: 

1. To measure the current in the series circuit in Fig 1.5(a) construct the circuit and then create a break 

the circuit as shown in Fig 1.5 (b) 

2. Rotate the multimeater dial in the mA position. 

3. Connect the red and black multimeater lead as shown in the Fig 1.5(b) (in series with the circuit) 

4. Multimeater should display the current 

I

5V
2.2KΩ 

1KΩ 

 5V
2.2KΩ 

Red wire

+

V

-

5.000 
AUTO

mA

Black Wire

Off

Ω 

Hz

mA

1KΩ 

Break in the 
circuit

 
(a) (b) 

Figure 1.5: Circuit diagram and actual connection for measuring current  
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Experiment No.  : 01 

Name of the Experiment : Uses of Different Types of Switches. 

 

 

OBJECTIVE: 
 

Different types of switches are used in electrical circuits. Each type of switch has a particular 

feature and its uses obviously depend on its inherent property. Although various types of 

switches may be involved in a particular application, we, however, concentrate our interest 

into the following types of switches: 

 

a. Single pole single throw (SPST) 

b. Single pole double throw (SPDT) 

c. Double pole single throw (DPST) 

d. Double pole double throw (DPDT) 

 

 

SCHEMATIC DIAGRAM: 
 

SPST

SPDT

DPST

DPDT
 

 

Figure 1.1: Different types of switches 

 

 

 

EQUIPMENTS: 
 

• Power cord-1 piece 

• SPST switch-2 pieces 

• SPDT switch-2 pieces 

• Lamps: 60W-1piece 

  100W-1piece 
USES OF DIFFERENT TYPES OF SWITCHES 
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PROCEDURES: 
 

1. Connect a bulb so that it can be operated from the source by an SPST switch. 

2. Connect a bulb so that it may be switched on by either of two SPST switches. 

3. Connect two bulbs (one 60W and one 100W) so that either may be operated from a 

common source by its own switch. 

4. Connect two bulbs (one 60W and one 100W) so that both may be operated 

simultaneously from a common source by one SPST switch. 

5. Connect a bulb so that it may be operated independently by either of two SPDT 

switches from a source. 

 

ASSIGNMENTS: 
 

1. For each of the cases given below, mention whether the switches of procedure 2 are 

dependent on each other to turn the lamp ON: 

a. When the switches are connected in series. 

b. When the switches are connected in parallel. 

2. Which method of procedure 4 is preferable and why? 

3. Explain the variations of the brightness level of the two lamps in procedure 4. 

4. What are the applications of the arrangement of procedure 5? 

5. What is the drawback of the switch connection of the circuit in Figure 1.2? 

 

AC

L

N

 
 

Figure 1.2: Circuit diagram for assignment no.-5 
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Experiment No.  : 02 

Name of the Experiment : Verification of Ohm’s Law. 

OBJECTIVE: 

 

To verify the following two equivalent forms of Ohm’s Law: 

 

a. Express I as a function of V and R. 

b. Express V as a function of I and R. 

THEORY: 

 

Ohm’s law describes mathematically how voltage ‘V’, current ’I’ and resistance ‘R’ in a 

circuit are related. According to this law: 

 

“The current in a circuit is directly proportional to the applied voltage and inversely 

proportional to the circuit resistance”. 

 

Formula for voltage: 

For a constant value of R, V is directly proportional to I     

  i.e. V = IR 

 

Formula for current: 

For a constant value of V, I is inversely proportional to R      

  i.e. I = V/R 

 

EQUIPMENTS: 

 

• Variable DC power supply -1 piece 

• Digital multimeter (DMM)/ Analog multimeter-1 piece. 

• Resistances: 1 KΩ, 2.2 KΩ, 3.3 KΩ, 4.7 KΩ, 5.6 KΩ, 10 KΩ -1 piece each. 

• Trainer Board 

• Connecting Wires. 

 

CIRCUIT DIAGRAM: 

+

-

A

R =

+

-

Ammeter

Voltmeter

Variable

DC Source
V

R
1K

=

 
Figure 2.1: Verification of Ohm’s Law 

 OHM’S LAW 
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+

-

A

R =






+

-

Ammeter

Voltmeter

 DC Source

(20 V)



V

R1K=

 

Figure 2.2: Verification of Ohm’s Law 

 

PROCEDURES: 

 

Current versus voltage: 

 

a. Construct the circuit of Figure 2.1. Do not switch on the power supply. 

b. Turn on the power supply and adjust it to 5V by using Voltmeter. Measure the current 

I by ammeter and record it in the Table 2.2. 

c. Increase the values of voltage as shown in the Table 2.2. Measure the current I in turn 

and record the values in Table 2.2. 

d. Calculate the values of current I by using I=V/RT. Use measured values of resistances. 

 

Current versus resistance: 

 

a. Construct the circuit of Figure 2.2. Do not switch on the power supply. 

b. Turn on the power supply and adjust it to 20V by using Voltmeter. Measure the 

current I by ammeter for R=2.2 KΩ (Use measured values) and record it in the Table 

2.3. 

c. Turn off the power supply and remove the resistance 2.2 KΩ. Replace it by resistor 

3.3 KΩ. 

d. Now turn on the power supply. Measure and record the current I in turn, at each of the 

resistance settings shown in the Figure 2.2. 

e. Calculate the values of resistance RT by using RT=V/I. Use measured values of voltage 

and current. 



 

Department of Electrical & Electronic Engineering, AUST 

 

EEE -11 02 

 3 

OHM’S LAW 

DATA SHEET: 

 

Table 2.1: Measuring Resistances by using Ohmmeter 

 

Nominal values of R (kΩ) 
Measured values of R by 

using Ohmmeter (kΩ) 

1  

2.2  

3.3  

4.7  

5.6  

10  

 

Table 2.2: Current versus voltage 

 

Supply 

Voltage (V) 

Measured I by using 

Ammeter (mA) 

RT = R1K + R2.2K [Use 

measured values of R] 

(kΩ) 

Calculate I (mA) 

I=V/RT 

5    

10    

15    

20    

25    

 

Table 2.3: Current versus resistance 

 

Supply 

Voltage (V) 

Measured I by using 

Ammeter (mA) 

RT  (kΩ) 

Use measured values of R 

Calculate  

RT =V/I (kΩ)  

 

20  
RT = R1K + R2.2K 

 
    RT = 

20  
RT = R1K + R3.3K 

 
    RT = 

20  
RT = R1K + R4.7K 

 
    RT = 

20  
RT = R1K + R5.6K 

 
    RT = 

20  
RT = R1K + R10K 

 
    RT = 

 

__________________________ 

         Signature of the Teacher 

OHM’S LAW 
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ASSIGNMENTS: 

 

1. What can you say about the relationship between voltage and current, provided that 

the resistance is fixed? 

 

2. Plot a graph of I versus V keeping the value of resistance constant. Use measured 

values of I and V. Comment on the graph briefly. 

 

3. Plot a graph of I versus RT keeping the value of supply voltage constant. Use 

measured values of I and RT. Comment on the graph briefly. 
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Experiment No.          : 03 

Name of the Experiment: To investigate the characteristics of a series DC circuit 

and to verify Kirchoff’s Voltage Law (KVL). 

 

OBJECTIVE: 

 

The objective of this experiment is to investigate the characteristics of a series DC circuit and 

to verify Kirchoff’s Voltage Law (KVL). 

 

THEORY: 

 

In a series circuit (Figure 3.1) the current is same through all of the circuit elements. 

 

The equivalent Resistance,   RT =R1 + R2 + R3. 

 

By Ohm’s Law, the Current is 

T

Supply

R

V
I =  

KVL states that the voltage rises must be equal to the voltage drops around a close circuit. 

Applying Kirchoff’s Voltage Law around closed loop of Figure 3.1, we find, 

 

321 VVVVSupply ++=  

 

Where,   V1= IR1,  V2= IR2,  V3=IR3 

 

Current I is same throughout the circuit for figure 3.1. 

 

The voltage divider rule states that the voltage across an element or across a series 

combination of elements in a series circuit is equal to the resistance of the element divided by 

total resistance of the series circuit and multiplied by the total impressed voltage. For the 

elements of Figure 3.1 

 

TR

ER
V 1

1 = ,  
TR

ER
V 2

2 = ,  
TR

ER
V 3

3 =  

EQUIPMENTS: 

 

• Variable DC power supply -1 piece 

• Digital Multimeter (DMM)/ Analog multimeter-1 piece. 

• Resistances: 1kΩ, 2.2kΩ, 4.7kΩ -1 piece each. 

• Trainer Board-1 piece 

• Connecting Wires. 

SERIES DC CIRCUIT & KVL 
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CIRCUIT DIAGRAM: 
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Figure 3.1 
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Figure 3.2 
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Figure 3.3  

 

SERIES DC CIRCUIT & KVL 

 

PROCEDURE: 

 

1. Measure the resistances having values 100Ω, 220Ω & 470Ω by using Ohmmeter and 

record the values in Table 3.1. 

2. Construct the circuit as shown in Fig 3.2. 

3. Then measure input resistance RT across points A-B using Ohmmeter and record that 

value in Table 3.1. 

4. Now construct the circuit as shown in Fig 3.3. Turn on the DC power supply and set 

the DC supply to 20V by using Voltmeter. 

5. Measure voltage across each resistor with Voltmeter and record in the Table 3.1 

6. Calculate V1, V2 and V3 using Voltage Divider Rule (VDR). [Use measured values of 

resistances for all calculations.] 

 

 

 

ASSIGNMENTS: 

 

1. What can you deduce about the characteristics of a series circuit from observation 

Table 3.1? 

 

2. From the data found in Table 3.1, mathematically prove that the current in the series 

network of figure 3.3 is equal for each resistance. 

 

3. Verify KVL from the data obtained in Table 3.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Department of Electrical & Electronic Engineering, AUST 

 

EEE -11 02 

4 

SERIES DC CIRCUIT & KVL 

DATA SHEET: 
 

Table 3.1: 
 

Nominal values 
of Resistance 

(kΩ) 

Measured values 
of Resistance by 

Ohmmeter 
(kΩ) 

Equivalent Resistance, RT 
Measured voltage 

across each 
resistor (V) 

Calculated Voltage 
using VDR (V) 

Measured RT by 
using Ohmmeter 

(kΩ) 

Calculated 
RT =R1 + R2 + R3 

(kΩ) 

R1=1.0  
 

 

V1=  

R2=2.2  V2=  

R3=4.7  V3=  

 

Calculation:  
 

 

 

 

 

 

 

 

 
___________________________ 

      Signature of the Teacher 
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Experiment No.          : 04 

Name of the Experiment: To investigate the characteristics of a Parallel DC circuit 

and to verify Kirchoff’s Current Law (KCL). 

 

OBJECTIVE: 
 
The objective of this experiment is to investigate the characteristics of a parallel DC 
circuit and to verify Kirchoff’s Current Law (KCL). 

 
THEORY: 
 
In a parallel circuit (Figure 4.1) the voltage across parallel elements is the same. 
 
The total or equivalent resistance (RT) is given by, 
 

NT RRRRR

11111

321

+−−−−−−−−+++=  

 
If there are only two resistors in parallel, it is more convenient to use, 

21

21

RR

RR
RT

+
=  

 
In any case, the total resistance will always be less than the resistance of the 
smallest resistor of the parallel network. 
 
KCL states that the currents entering a node must be equal to the currents leaving 
that node. For the network of Figure 4.1 the currents are related by the following 
expression: 

NT IIIII +−−−−−−−−+++= 321  

 
Applying current divider rule (CDR) for a circuit of only two resistors in parallel as 
shown in figure 4.2,  
 

21

2
1

RR

IR
I T

+
=  and         

21

1
2

RR

IR
I T

+
=  

 
For equal parallel resistors, the current divides equally and the total resistance is the 
value of one divided by the ‘N’ number of equal parallel resistors, i.e.: 
 

                             
N

R
RT =  
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PARALLEL DC CIRCUIT & KCL 

 

For a parallel combination of N resistors, the current I1 through R1 is: 

N

T

RRRR

R
II

1111

1

321

1
1

+−−−−−−−−+++

= = (IT * RT) /R1 

EQUIPMENTS: 
 

• Variable DC power supply -1 piece 

• Digital Multimeter (DMM)/ Analog multimeter-1 piece. 

• Resistances: 1KΩ, 2.2 KΩ, 4.7 KΩ -1 piece each. 

• Trainer Board-1 piece 

• Connecting Wires. 
 

CIRCUIT DIAGRAM: 

R
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Supply

R
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I
1 I

2
I
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Figure 4.1 
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Figure 4.2      Figure 4.3 
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Figure 4.4 

R
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PARALLEL DC CIRCUIT & KCL 

 

PROCEDURE: 
 

1. Measure the resistances having values 1 KΩ, 2.2 KΩ & 4.7 KΩ by using 

Ohmmeter and record the values in Table 4.1. 

2. Construct the circuit as shown in Fig 4.3. 

3. Then measure input resistance RT across points A-B using Ohmmeter and 

record that value in Table 4.1. 

4. Now construct the circuit as shown in Fig 4.4. Turn on the DC power supply 

and set the DC supply to 15V by using Voltmeter. 

5. Measure the currents IT, I1, I2 and I3 by using Ammeter and record in the Table 

4.1. 

6. Calculate I1, I2 and I3 using Current Divider Rule (CDR). [Use measured values 

of resistances for all calculations.] 

 

 

ASSIGNMENTS: 
 

1. What can you deduce about the characteristics of a parallel circuit from 
observation Table 4.1? 

 
2. From the data found in Table 4.1, Calculate I1, I2 and I3 using Ohm’s Law. 

 
3. Verify KCL from the data obtained in Table 4.1. 
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PARALLEL DC CIRCUIT & KCL 

DATA SHEET: 
 

Table 4.1: 
 

Nominal values 
of Resistance 

(KΩ) 

Measured values 
of Resistance by 

Ohmmeter 
(KΩ) 

Equivalent Resistance, RT 

Measured current 
through each 
resistor (mA) 

Calculated Current 
using CDR (mA) 

Measured RT by 
using Ohmmeter 

(KΩ) 

Calculated 

321

1111

RRRRT

++=  

(KΩ) 

R1=1  
 

 

I1=  

R2=2.2  I2=  

R3=4.7  I3=  

 

Calculation:  
 

 

 

 

 

 

 

 

___________________________ 
      Signature of the Teacher 
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Experiment No.  : 05 

Name of the Experiment : Use of Galvanometer as Ammeter and Voltmeter. 
 
OBJECTIVE: 
The objective of this experiment is to show how a galvanometer can be used as an 
ammeter and a voltmeter. 
 

THEORY: 
An ammeter is an instrument, while connected in series with a branch, measure the 
current of that branch. Ideally it should be of zero resistance, so that there is no 
voltage drop across it and hence it has no effect on the circuit where it is connected. 
 
A voltmeter is an instrument, while connected in parallel with a branch, measure the 
voltage of that branch. Ideally it should be of infinite resistance, so that it draws no 
current and hence it has no effect on the circuit where it is connected. 
 
A galvanometer is an instrument that can detect current. This meter can be used 
either as an ammeter or as a voltmeter. To use this meter as an ammeter, a very small 
resistance is connected in parallel with it so that a small voltage drop will occur 
across it. When the galvanometer is used as a voltmeter, a very high resistance is 
connected in series with it so that it will draw a little current. 
 

EQUIPMENTS: 
 

• Trainer Board - 1 piece. 

• Digital Multi-meter - 1 piece. 

• Galvanometer - 1 piece. 

• Potentiometer – (10KΩ) 1 piece. 

• Resistances: 10 Ω, 100 Ω, 1 KΩ, 10KΩ -1 piece each. 
 

PROCEDURES: 
 

PART A: 
 

1. Construct an ammeter using a galvanometer as shown in Figure 5.1 
 

G 

 
Figure 5.1: Constructed Ammeter circuit 
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GALVANOMETER AS AMMETER 

 

2. Now place the constructed ammeter in the circuit shown below in Figure 5.2. 
 

5V

 

GA

Constructed

Ammeter

Multi-meter in

Ammeter mode

A

B

 
 

Figure 5.2: Use of galvanometer as an ammeter. 
 

3. Connect the constructed ammeter and vary the pot until full-scale deflection is 
obtained. Then disconnect the constructed ammeter and the place actual 
ammeter. Measure the current from multi-meter in ammeter mode. 

 
    The value of each division of the galvanometer scale  

 
 

 

 

4. Connect the constructed ammeter and vary the pot. Note the number of 
divisions deflected by the galvanometer. Then disconnect the constructed 
ammeter and place the actual ammeter Measure the current from multi-meter 
in ammeter mode. Record these readings in Table 5.1. 

 

5. Increase the pot several times. Repeat step 4 for each increment of pot and 
record the readings in Table 5.1. 

 
Table 5.1: Data for Ammeter. 
 

No. of divisions 
deflected by the 

galvanometer 

Current = No. of divisions 
deflected X Value of each 

division. 
(mA) 

Measured Current 
(Reading from multi-meter 

in ammeter mode)  
(mA) 

   

   

   

   

   

 

==
scale. fullin  deflected divisions of No.

current Measured
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GALVANOMETER AS VOLTMETER 

 
PART B: 
 

1. Construct a voltmeter using a galvanometer as shown in Figure 5.3. 

G



 
 

Figure 5.3: Constructed Voltmeter circuit 
 

2. Now place the constructed voltmeter in the circuit shown below in Figure 5.4. 
 

5V



 G



V

Constructed 

Voltmeter

Multi-meter in 

Voltmeter mode

B

A

 
 

Figure 5.4: Use of galvanometer as voltmeter. 
 

3. Connect the constructed voltmeter and vary the pot until full-scale deflection 
is obtained. Then place the actual voltmeter Measure the voltage from multi-
meter in voltmeter mode. 

 
     The value of each division of the galvanometer scale  

 
 

 

  

 

4. Connect the constructed voltmeter and vary the pot. Note the number of 
divisions deflected by the galvanometer. Then place the actual voltmeter 
Measure the voltage from multi-meter in voltmeter mode. Record these 
readings in Table 5.2. 

 

5. Increase the pot several times. Repeat step 4 for each increment of pot and 
record the readings in Table 5.2. 

==
scale. fullin  deflected divisions of No.

Voltage Measured
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GALVANOMETER AS VOLTMETER 

 
 

Table 5.2: Data for Voltmeter. 
 

No. of divisions 
deflected by the 

galvanometer 

Voltage = No. of divisions 
deflected X Value of each 

division. 
(v) 

Measured Voltage 
(Reading from multi-meter 

in voltmeter mode)  
(v) 

   

   

   

   

   

 

 
ASSIGNMENTS: 
 

1. Comment on the results found in Part A and Part B.  
 

2. Suppose we want to measure a current greater than the full-scale deflection of 
the constructed ammeter (Figure 5.1). In this case, should the resistance in 
parallel with the galvanometer be increased or decreased? Explain in brief. 

 
 
 
 
 
 
 

 

 

 
 

 

 

 

 

 

 
 



Experiment no: 06 

Experiment name: Introduction to LTspice and verification of superposition theorem using 

simulation. 

In this experiment, we will learn how to analyze electric circuits in LTspice. The theory behind the 

studied circuits can be found in any standard circuit theory text book. It is a good idea to do some hand 

calculations for the circuits that are given and compare them with LTspice results. 

6.1a Installation of  LTspice 

 
Installation of LTspice is quite easy. In order to install LTspice, search for “ltspice download” in Google (Fig. 

6.1) and open the first result (Fig. 6.2). 

 

Fig. 6.1: Searching for LTspice download page 

 

Fig. 6.2: LTspice webpage 

 



 
Scroll down the screen until you see the download link (Fig. 6.3). Download the suitable version based on your 

operating system.  

 
Fig. 6.3: Download link 

After downloading the file, install it. The LTspice environment is shown in Fig. 6.4. 

Fig. 6.4: LTspice environment 



If you click the Help> Help Topics (Fig. 6.5), LTspiceHelp appears on the screen (Fig. 6.6). 

Fig. 6.5: Help menu 

 

Fig. 6.6: LTspice Help window 



The Dot Commands section of the help is a good reference to learn LTspice commands (Fig. 6.7). 

Fig. 6.7: Dot Commands section of LTspice Help 

 

LTspice has an “examples” folder which contains many inspiring simulations. In order to open the 

“examples” folder, click the open icon (Fig. 6.8) and then go to the path that you installed LTspice (Fig. 6.9). 

 

Fig. 6.8: Open icon 

 

 

 

 

 

 

 

 



Fig. 6.9: Examples folder 

Open the “examples” folder (Fig. 6.10). 

Fig. 6.10: Educational folder 



Open the “Educational” folder (Fig. 6.11). Now you have access to the ready to use sample simulation files. 

Fig. 6.11: Available sample simulation files 

6.1b Example 1: Simple Resistive Voltage Divider 

In this example, we want to simulate the behavior of following simple voltage divider circuit (Fig. 6.12) of 

experiment no 02. 

                                    

20V

1 k  

2.2 k  

 

Fig. 6.12 Simple voltage divider circuit 

 

Run the LTspice (Fig 6.13). 



Fig 6.13 LTspice environment 
 

Click the New Schematic icon (Fig 6.14). This opens a new schematic for you (Fig 6.15). 

 

Fig 6.14 New Schematic icon 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Fig 6.15 New schematic file is opened 
 

Click the resistor icon (Fig 6.16). After clicking the resistor icon, the mouse pointer changes to a resistor. 

If you press the Ctrl+R, the resistor will be rotated. Press the Ctrl+R once and then click on the schematic 

to add a resistor to it (Fig 6.17). 

 

Fig 6.16 Resistor icon 



Fig 6.17 Addition of a resistor to the schematic 
 

Add another resistor to the schematic (Fig 6.18), and after that, press the Esc key of your keyboard. 

 

Fig 6.18 Addition of second resistor to the schematic 



Clicking the Resistor icon (Fig 6.16) is not the only way to add resistors to the schematic. You can press the 

‘R’ key of your keyboard as well. The shortcut keys of LTspice are shown in Fig 6.19. It is a good idea to 

memorize these shortcuts since they help you to draw the schematic easier and faster. 

 

Fig 6.19 Edit menu 

 

Click on the Component icon (Fig 6.20). 

 

 

Fig 6.20 Component icon



After clicking the Component icon, the Select Component Symbol window (Fig 6.21) appears. Enter “voltage” 

in the component search box to find the voltage source block. The current source block can be found by 

searching for “current,” as well (Fig 6.22). 

Fig 6.21 Voltage source block 



 

Fig 6.22 Current source block 
 

Add a voltage source block to the schematic (Fig 6.27). 



 

Fig 6.27 Addition of a voltage source to the schematic 
 

You can delete a component with the aid of scissor icon (Fig 6.28). Click the scissor icon (or press F5) and 

then click on the component that needs to be removed. 
 

Fig 6.28 Cut icon 

You can duplicate a component with the aid of Copy icon (Fig 6.29). Click the Copy icon (or press F6) and then 

click on the component that you want to make a copy of it. After clicking on the component, a copy of that 

component is attached to the mouse pointer. If you click on the schematic, the copied component will be 

attached to the schematic. 

Fig 6.29 Copy icon 



 

Use the Wire icon (Fig 6.30) to connect the components together (Fig 6.31). 

Fig 6.30 Wire icon 

Fig 6.31 Connecting the components together 

Use the ground icon (Fig 6.32) to add ground to your circuit (Fig 6.33). If you try to run a schematic 

without ground, the error message shown in Fig 6.34 appears. 

 

 

Fig 6.32 Ground icon 

 



 

Fig 6.33 Addition of ground to the schematic 
 
 

Fig 6.34 Error message for a 

circuit without ground 

 

 

 

 

 

 

 

 

 

 

Right click on the voltage source V1 and enter 20 to the DC value[V] box (Fig 6.35) and click the OK 

button. If you click the Advanced button in Fig 6.35, the window shown in Fig 6.36 appears and permits you 

to produce more complicated waveforms. In this example, we need a simple DC voltage source, so there is no 

need to change the settings of Fig 6.36. 

 

Fig 6.35 Voltage source 

settings 

 

 

 

 

 

 



 

Fig 

6.36 Voltage source settings 

 

After clicking the OK button of Fig 6.36, the schematic changes to what is shown in Fig 6.37. The value of 

DC voltage source is shown behind it. 

Fig 6.37 Value of voltage source is shown on the schematic. 

Right click on the resistor R1 and enter 1k to the Resistance [Ω] box (Fig 6.38). Then click the OK button. 
After clicking the OK button, the schematic changes to what is shown in Fig 6.39. The value of resistor R1 is 

shown behind it. List of prefixes that can be used in LTspice is shown in Table A. 

 



 

 

Fig 6.38 Entering the value of 

resistor R1 

 

 

 

 

 

 

 

 

 

 

 

Fig 6.39 Value of resistor R1 is shown on the schematic 

 

 

 

 

 

 

 

 

 

 



 

Table A Prefixes that can be used in LTspice 

 

Unit (prefix) Unit Multiple 

T Tera 1012 

G Giga 109 

Meg Mega 106 

k Kilo 103 

m Milli 10−3 

u Micro 10−6 

n Nano 10−9 

p Pico 10−12 

f Femto 10−15 

 
Right click on the resistor R2 and enter 2.2k to the Resistance [Ω] box (Fig 6.40). Then click the OK button. 

After clicking the OK button, the schematic changes to what is shown in Fig 6.41. The value of resistor R2 is 

shown behind it. 
 

Fig 6.40 Entering the value of 

resistor R2 

 

 

 

 

 

 

 

 

 

 

 

Fig 6.41 Value of resistor R2 is shown on the schematic 

 

When you open a new schematic in LTspice, the default name Drafn (n shows a number) is assigned to it. If you want to 

save the file with your desired name, you need to use the File> Save As (Fig. 6.42). After Save As the file with desired 

name, you can click the Save icon (Fig. 6.43) to save the changes you apply to the schematic file. 

 

 



 

 

 

 

 

Fig. 6.42: File> Save As 

 

 

 

 

 

 

 

 

Fig. 6.43: Save icon 

 

 

The Run icon (Fig. 6.44) can be used to determine the type of simulation and run the simulation. In this example, 

we want to find the steady-state DC voltages/currents. In order to do this, click the Run icon, (Fig. 6.44) and open the 

DC op pnt tab (Fig. 6.45).  

 

Fig. 6.44: Run icon 

 

 



 

Fig. 6.45: DC op pnt tab 

After clicking the OK button, the “.op” command is added to the schematic (Fig. 6.46) and the result shown in Fig. 

6.47 appears. 

 
Fig. 6.46: “.op” command is added to the schematic 



 

 
Fig. 6.47: Simulation result for Example  1. 

 

6.2a Verification of Superposition Theorem 

Superposition theorem states that; “In any linear bilateral network having multiple sources, the response (voltage 

and current) in any element is equal to the summation of all responses caused by individual source acting alone.”  In 

this experiment, we measure the current (or voltage) due to combination of sources of the original circuit and then 

measure the current for each individual source. Then verify the theorem by comparing the algebraic sum to of the 

currents due to individual sources with the current due to original setup. In this example, we want to verify superposition 

theorem for the following circuit (Fig. 6.48). 

CASE 1: All the sources (E1 and E2) are active 

Fig 6.48: Experimental circuit (case 1: all the sources E1 and E2 active).



 

Run the LTspice (Fig 6.49). 

Fig 6.49: LTspice environment 

 

Click the New Schematic icon (Fig 6.50). This opens a new schematic for you (Fig 6.51). 

 

Fig 6.50: New Schematic icon 



 

 

Fig 6.51: New schematic file is opened 

 

Click the resistor icon (Fig 6.52). After clicking the resistor icon, the mouse pointer changes to a resistor. If you 

press the Ctrl+R, the resistor will be rotated. Press the Ctrl+R once and then click on the schematic to add a resistor 

to it (Fig 6.53). 

 

Fig. 6.52: Resistor icon



 

 

Fig 6.53: Addition of a resistor to the schematic 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Fig 6.54: Addition of second resistor to the schematic 

 

Add another two resistors to the schematic (Fig 6.54), and after that, press the “Esc” key of your keyboard. 



 

 

Add a voltage source block to the schematic (Fig. 6.55). 

 

Fig. 6.55: Addition of a voltage source to the schematic 

 

Use the Wire icon (Fig. 6.56) to connect the components together (Fig. 6.57). 
 

Fig. 6.56: Wire icon 

Fig. 6.57: Connecting the components together 

 

 

 

 



 

Use the ground icon (Fig. 6.58) to add ground to your circuit (Fig. 6.59).  
 

   Fig. 6.58: Ground icon 

 

 

 

 

 

 

 

 

Fig. 6.59: Addition of ground  

to the schematic 

 
 

 

 

 

 

 
Right click on the voltage source V1 and enter 10 to the DC value[V] box (Fig. 6.60) and click the OK button. Do 

the same for voltage source V2 and enter 5 to the DC value[V] box. 

 

Fig. 6.60: Voltage source 

settings 

 

 

 

 

 

 
After clicking the OK button, the schematic changes to what is shown in Fig. 6.61. The value of DC voltage source 

is shown behind it. 



 

 

Fig. 6.61: Value of voltage source is shown on the schematic. 

Right click on the resistor R1 and enter 220 to the Resistance [Ω] box (Fig. 6.62). Then click the OK button. After 

clicking the OK button, the schematic changes to what is shown in Fig. 6.63. The value of resistor R1 is shown behind 

it.  

 

 

 

Fig. 6.62: Entering the value of 

resistor R1 

 

 

 

 

 

Fig. 6.63: Value of resistor R1 is shown on the schematic 



 

 
Right click on the resistor R2 and enter 560 to the Resistance [Ω] box (Fig. 6.63). Then click the OK button. The 

value of resistor R2 is shown behind it. Do the same for the resistor R3 and enter 470 to the Resistance [Ω] box. After 

clicking the OK button, the schematic changes to what is shown in Fig. 6.64. 

Fig. 6.64: Value of resistor R2 is shown on the schematic 

 

You can change the components labels by right clicking on them and entering the new name. For instance, 

if you right click on the “V1” label in Fig. 6.64, the window shown in Fig. 6.65 appears and permits you to 

enter a new name to the voltage source. Enter “E1” for the 10V source and “E2” for the 5V source. The circuit 

with modified levels is shown in Fig. 6.66. 
 

 

Fig. 6.65: Entering a new 

name 

 

 

 

 

 

 

 
Fig. 6.66: Experimental circuit 

with labelled components 

 

 

 

 

 

 

 

 

 
 



 

You can use the Label Net icon (Fig. 6.67) to give the desired names to the circuit nodes. After clicking the Label 

Net icon, the window shown in Fig. 6.68 appears and permits you to enter the desired name. 

 

Fig. 6.67: Label Net icon 

 
 

 

 

 

 

 

 

 

 

Fig. 6.68: Net Name window 

Let’s give the name “a” to the node which is connected to the upper terminal of resistor R1. To do this, click the 

Label Net icon and enter “a” to Net Name window and click the OK button (Fig. 6.69). After clicking the OK button, 

the entered name (a) is attached to the mouse pointer and a small square is under it. Place the square on the upper 

terminal of resistor R1 (Fig. 6.70) and click. After clicking, the upper terminal of R1 is renamed to “a” (Fig. 6.71). 

Fig. 6.69: Entering “a” to Net Name window 

 



 

 

Fig. 6.70: Assigning the name “a” to upper terminal of R1 (=right terminal of R2) 

 

 

 

Fig. 6.71: Upper terminal of R1 (=right terminal of R2) is renamed to “a” 
 

 

 

 

 

 

 



 

Now do the same to name the node connected to the lower terminal of R1 to “b” (Fig. 6.72). 

 

Fig. 6.72: Renaming the ground node to “b” 

 
You can add text to the schematic by clicking the Text icon (Fig. 6.73). After clicking the Text icon, the window 

shown in Fig. 6.74 appears and permits you to enter the desired text. After entering the desired text, click the OK 

button and then click on the schematic to add the text to it (Fig. 6.75). 

Fig. 6.73: Text icon 

 

 

 

 

 

 

 

 

 



 

Fig. 6.74: Comment radio button 

 

 

Fig. 6.75: Addition of a comment to the schematic 

 
You can zoom in/out with the aid of mouse scroll button or the icons shown in Fig. 6.76. If you press the 

spacebar key of your keyboard, the best settings are selected to show the drawn schematic. 

Fig. 6.76: Zoom icons 

 

 



 

If you want to save the file with your desired name, you need to use the File> Save As (Fig. 6.77). After Save As the file 

with desired name, you can click the Save icon (Fig. 6.78) to save the changes you apply to the schematic file. 

 

 

 

Fig. 6.77: File> Save As 

 

 

 

 

 

 

 

 

Fig. 6.78: Save icon 

 

 

The Run icon (Fig. 6.79) can be used to determine the type of simulation and run the simulation. In this example, 

we want to find the steady-state DC voltages/currents. In order to do this, click the Run icon, (Fig. 6.79) and open the 

DC op pnt tab (Fig. 6.80).  

 

Fig. 6.79: Run icon 

 

 



 

Fig. 6.80: DC op pnt tab 

After clicking the OK button, the “.op” command is added to the schematic (Fig. 6.81) and the result shown in 

Fig. 6.82 appears. Record the simulation data in Table 6.1. 

Fig. 6.81: “.op” command is added to the schematic 

 

 

 



 

Fig. 6.82: Simulation result for case 1 (all the sources E1 and E2 active). 

 

Table 6.1: Data for verification of Superposition theorem 

 

Cases Verification 

Case 1 Case 2 Case 3 Case 1= Case 2+Case 3 

[E1 & E2 

active] 

[Only E1 

active] 
[Only E2 active] 

Vab 

(volt) 

I  

(mA) 

V΄ab 

(volt) 

I΄ 

(mA) 

V΄΄ab 

(volt) 
I΄΄ (mA) 

Vab = V΄ab+ V΄΄ab 

(volt) 

I= I΄+ I΄΄  

(mA) 

      
  

 

 



 

CASE 2: Make voltage source E2 deactivate and measure the voltage V΄ab and record the value 

Fig. 6.83: Only E1 activated 

 

Draw the circuit in LTspice (Fig. 6.83). 

Fig. 6.83: LTspice execution of experimental circuit (case 2) 

 

 



 

Click the Run icon, select DC op pnt tab, click OK and record the simulation data (Fig. 6.84) in Table 6.1. 

Fig. 6.84: Simulation result for case 2 (only E1 active) 

 

CASE 3: Make voltage source E1 deactivate and measure the voltage V΄΄ab and record the value 

Fig. 6.85: Only E2 activated 

 

 

 

 



 

Draw the circuit in LTspice (Fig. 6.86). 

Fig. 6.86: LTspice execution of experimental circuit (case 2) 

 

Click the Run icon, select DC op pnt tab, click ‘OK’ and record the simulation data (Fig. 6.87) in Table 6.1. 

Now verify superposition theorem.  

Fig. 6.87: Simulation result for case 3 (only E2 active) 



 

ASSIGNMENTS: 

1. Verify Superposition theorem for the circuit shown in Fig. 6.88. 

Fig. 6.88: Experimental circuit 2 

 

 

 

 

 

 

 

 

 

 

Cases Verification 

Case 1 Case 2 Case 3 Case 1= Case 2+Case 3 

[E1 & E2 active] 
[Only E1 

active] 
[Only E2 active] 

Vab (volt) 
I  

(mA) 

V΄ab 

(volt) 

I΄ 

(mA) 

V΄΄ab 

(volt) 
I΄΄ (mA) 

Vab = V΄ab+ V΄΄ab 

(volt) 

I= I΄+ I΄΄  

(mA) 

      
  



Experiment 7:  

Experiment name:  Finding Equivalent resistance using simulation in LTSpice by      

Potentiometer method, Voc/Isc method and Vs/Is method. 

 Theory 

In this experiment equivalent resistance with respect to two terminals is calculated through 

simulation. In potentiometer method a variable resistance in placed in between the two terminals and 

its resistance is varied until the voltage across the resistor is half the open circuit voltage between the 

terminals. In the Voc/Isc method the open circuit voltage and short circuit current are measured to 

find equivalent resistance. In the Vs/Is method a test voltage source is placed between the terminals 

by removing all other sources in the circuit and then the test voltage Vs and current through the source 

Is is used to calculate equivalent resistance.  

Potentiometer Method 

The following process can be used to find equivalent resistance by the potentiometer method 

through simulation in LTSpice. 

      Figure : 1 

1) Construct the circuit as shown in figure 1  in a new schematic. 

2) Label the nodes across which the equivalent resistance is to be found as a and b using label 

net and perform DC operating point analysis .op to find the voltages of node a and b. Find 

the voltage difference between the nodes and divide it by 2. 

3) Place a resistor (R14 in figure 2) between the nodes a and b as shown by figure 2. 



4)  Right click on the resistor between a and b, and set its resistance parameter as {R}. (The 

curly brackets are needed but any name can be set)

 

     Figure: 2 

 

      Figure: 3 

5) To set multiple values of {R} in the simulation click the SPICE Directive on the top right 

corner to open the Edit Text on the Schematic box as shown in figure 3. 

6) Write .step  as shown in figure 3.  

7) Right Click the .step in the schematic shown in figure 4. 



     Figure: 4 

8) The .step Statement Editor  in figure 5 appears and set the parameters as shown in figure 5 

to change the value of R from 1 to 10K with increment of 10 ohm.

 

Figure: 5 

9) Click Ok and run the simulation with the RUN button. 

10) From the window shown in figure 6 place voltage markers at node a and b. 

11) Then the trace on figure 7 appears 



 

Figure: 6 

12) Move the cursor on the trace (as shown in figure 7) to point 11.13 mV which is half of the 

open circuit voltage of node a and b found initially. 

13) Then the corresponding resistance shown in figure 8 is the equivalent resistance of the 

circuit with respect to node a and b. 



 

      Figure: 7 

 

Figure: 8 

 

 

 

 

 

 



Voc by Isc method 

The following process can be used to find equivalent resistance by the Voc by Isc method through 

simulation in LTSpice. 

1) Construct the circuit as shown in figure 9  in a new schematic. 

2) Label the nodes across which the equivalent resistance is to be found as a and b using label 

net and perform DC operating point analysis .op to find the voltages of node a and b as 

shown in figure 10 . The voltage difference between node a and b is the open circuit voltage.

 

     Figure: 9 

 

Figure: 10 

3) Short the circuit between the nodes a and b as shown in figure 11 and perform DC Operating 

point analysis. 

4) From the output window shown in figure 12 note the short circuit current through the 

resistor R3. 

5) Then divide open circuit voltage by short circuit current to get the equivalent resistance. 



 

Figure: 11 

 

Figure: 12 

 

 

 



Vs by Is method 

The following process can be used to find equivalent resistance by the Vs by Is method through 

simulation in LTSpice. 

1) Construct the circuit as shown in figure 13  in a new schematic. 

2) Set the name of the node a and b and perform the DC operating point analysis .op. 

3) From the output window shown in figure 14 and figure 15 find the Vs and Is in the circuit. 

4) Then Vs divided by Is gives the equivalent resistance with respect to node a and b.

 

     Figure: 13 



 

Figure: 14 

 

Figure: 15 
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Experiment No.  : 08 

Name of the Experiment : Verification of Thevenin’s Theorem and 
  Maximum Power Transfer Theorem. 

 
 

OBJECTIVE: 

 

To verify and interpret two most important theorems: 

  

(1) Thevenin’s Theorem 

  

(2) Maximum Power Transfer Theorem. 

 

 

 

THEORY: 

 

Thevenin’s Theorem states that the voltage across or current through element of a network 

can be calculated by constructing a Thevenin’s equivalent circuit. This circuit is represented 

by a voltage source, called Thevenin’s voltage, a resistance, called Thevenin’s resistance and 

the element itself – all connected in series. After removing the element Thevenin’s voltage 

and Thevenin’s resistance are calculated, where the open circuit voltage (Voc) measures 

Thevenin’s voltage (Vth) and the resistance looking through the open circuited terminals 

represents Thevenin’s resistance (Rth). 

 

The maximum power transfer theorem states that maximum power can be transferred to the 

load when the load resistance is equal to equivalent resistance looking through the terminals 

where the load is connected. 

 

 

EQUIPMENTS: 

 

• Variable DC Power Supply (20 V)-1 piece. 

• Trainer Board-1 piece. 

• Digital Multimeter-1 piece. 

• Resistances:  220 Ω -4 piece. 

• Rheostat (1k) - 2 piece. 

• Connecting Wires. 

 

 

THEVENIN’S THEOREM 

 

CIRCUIT DIAGRAM: 
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Figure 8.1: Circuit 01  

 









10V

a

b

+

-

Voc = Vth

 
 

Figure 8.2: Circuit setup for finding Voc or Vth 
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Figure 8.3: Circuit setup for finding Rth  
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Figure 8.4: Thevenin’s equivalent circuit 

THEVENIN’S THEOREM 

 

PROCEDURES: 

 

1. Connect the circuit as shown in figure-8.1.  Remove the load resistance (rheostat) as 

shown in figure-8.2. Measure the open circuited voltage, (Voc). This represents 

Thevenin’s voltage (Vth).  

 

2. Now construct the circuit as shown in figure-8.3. Make voltage source deactivate 

(Remove the source and short the terminals). To measure the resistance Rth 

(Thevenin’s equivalent resistance looking through terminals a-b), hold the ohmmeter 

at terminals a and b. 

 

3. Finally construct the Thevenin’s equivalent circuit as shown in figure-8.4.  

 

4. Connect the circuit as shown in figure-8.1. Vary the load resistance (rheostat) from 

100 Ω to 1K Ω with a 100 Ω stepping. For each step measure voltage across the load 

resistance (rheostat) and calculate the current (IL) through the load. Fill the table-8.1 

using these values. 

 

5. Now connect the same load resistance (rheostat) at the Thevenin’s equivalent circuit 

as shown in figure-8.4 and vary the load resistance (rheostat) from 100 Ω to 1K Ω 

with a 100 Ω stepping. For each step measure voltage across the load resistance 

(rheostat) and calculate the current IL. Fill the table-8.2 using these values. 

 

ASSIGNMENTS: 

 

1. Plot VL vs. RL curves for both original and equivalent circuits on the same graph. 

 

2. Plot IL vs. RL curves for both original and equivalent circuits on the same graph. 

 

3. Plot PL vs. RL curves for both original and equivalent circuits on the same graph. 

 

4. Comparing the graphs verify Thevenin’s Theorem. 

 

5. From PL vs. RL graphs verify maximum power transfer theorem. 
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DATA SHEET: 

**[Use measured values of resistances for all calculations.] 

Table 8.1: For original circuit 

 

RL  

() 

VL 

(Volt) L

L
L

R

V
I = (A) 

( )

L

L
L

R

V
P

2

= (W) 
( ) LLL RIP =

2

(W) 

100     

200     

300     

400     

500     

Rth = RL =     

600     

700     

800     

900     

1000     

 

SAMPLE CALCULATION: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

___________________________ 

      Signature of the Teacher 
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DATA SHEET: 

**[Use measured values of resistances for all calculations.] 

Table 8.1: For Thevenin’s equivalent circuit: 

 

RL  

() 

VL 

(Volt) L

L
L

R

V
I = (A) 

( )

L

L
L

R

V
P

2

= (W) 
( ) LLL RIP =

2

(W) 

100     

200     

300     

400     

500     

Rth = RL =     

600     

700     

800     

900     

1000     

 

SAMPLE CALCULATION: 

 

 

 

 

 

 

 

 

 

 

 

 

 

___________________________ 

      Signature of the Teacher 
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Experiment No.  : 09 

Name of the Experiment : Introduction to Oscilloscope Operation. 

 
 

OBJECTIVE: 
 
This experiment is designed for the under-graduate students to introduce themselves 
and to be familiar with the oscilloscope and its operation. This experiment will help 
the students to have basic ideas about key functions of different knobs of oscilloscope 
and also to know how to measure voltage/current of a circuit-using oscilloscope as a 
measuring instrument. 
 

FRONT VIEW OF THE LABORATORY OSCILLOSCOPE: 
 

Introduction to front Panel: 
 
The front panel consists of the following parts: 

• CRT 

• Vertical axis 

• Triggering 

• Time 

• Others 
OSCILLOSCOPE OPERATION 
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BRIEF DESCRIPTION:  
 

1. CRT: 
a) Power (6) 
    The main power switch. 
b) Inten (2)  
     Controls the brightness of the spot. 
c) Focus (3) 

      For focusing the spot for sharp image. 
d) Trace rotation (4) 
     For aligning the horizontal trace in parallel with graticule lines. 
e) Filter (33) 

 
2. Vertical axis: 

a) CH1 (X) input (8) 
Vertical input of CH1. When in X-Y mode this acts as an X-axis input 

b) CH2 (Y) input (20) 
Vertical input of CH2. When in X-Y mode this acts as a Y-axis input 

c) AC-GND-DC (10,18) 
Switch for selecting connection mode between input signal and vertical 
amplifier. 

d) Volt/Div (7,22) 
Selection of vertical axis sensitivity, from 5mV/Div to 5V/Div in 10 
ranges.   

e) Variable (9,21) 
f) CH1 & CH2 DC BAL (13,17) 
g) Position (11,19) 

Control the position of the vertical trace or spot. 

h) Vert mode (14) 
There are four positions to switch the operation of CH1 and CH2.When 
position in either CH1 or CH2; then oscilloscope operates as single 
channel instrument with CH1 or CH2 respectively. When position in 
DUAL then the oscilloscope operates as dual–channel of both CH1 and 
CH2. When position in ADD, then oscilloscope displays the algebraic 
sum (CH1+CH2) or difference (CH1-CH2). During difference operation, 
CH2 INV must be pushed. 

i) ALT/CHOP (12) 
When this switch is released then CH1 and CH2 are alternately 
displayed. When this switch is engaged then CH1 and CH2 are chopped 
and displayed simultaneously.  

j) CH2 INV (16) 
  This inverts the CH2 input signal when this knob is pushed in. 
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OSCILLOSCOPE OPERATION 

 
 

3. Triggering: 
a) EXT TRIG IN input terminal (24) 
b) SOURCE (23) 

1) CH1: When Vert mode switch is at DUAL/ADD position select 
CH1 for internal triggering. 

2) CH2: When Vert mode switch is at DUAL/ADD position select 
CH2 for internal triggering. 

3) TRIG.ALT: It will alternately select CH1 and CH2 for internal 
triggering. 

4) Line 
5) EXT 

c) SLOPE (26) 
1) ‘+’: Triggering occurs when triggering signal crosses triggering level 

in +ve going direction. 
2) ‘—': Triggering occurs when triggering signal crosses triggering 

level in –ve going direction. 
d) LEVEL (28) 

  To display synchronized stationary waveform and set a start point of it.    
e) TRIGGER MODE (25) 

 
4. Time Base: 

a) TIME/DIV (29) 
                    Ranges are available from 0.2 μsec/div to 0.5 sec/div in 20 steps. 

X-Y mode: This position is used when oscilloscope functions as an X-Y 
oscilloscope. 

b) SWP.VAR (30) 
c) Position (32) 

Control the position of the horizontal trace or spot. 

d) x 10 MAG (31) 
                      When this button is pushed, magnification of 10 occurs. 

 
5. Others: 

a) CAL (1) 
This terminal gives the calibration voltage of 2 Vp-p, 1 kHz, and positive 
square wave.    

b) GND (15) 
                      The ground terminal of the oscilloscope mainframe.           
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OSCILLOSCOPE OPERATION 

 
 

BASIC OPERATION WITH OSCILLOSCOPE: 
 

1. Single channel operation. 
2. Dual-channel operation. 
3. ADD operation. 
4. Frequency measurement 
5. Sweep Magnification 
6. X-Y Operation. 
7. To display two input signals still on oscilloscope  

 
EQUIPMENTS: 
 

1. Oscilloscope – 1 unit 
2. Oscilloscope probe (10 x)– 2 pieces 
3. Signal Generator – 1 unit 
4. Signal Generator probe – 1 piece 
5. Resistor 1kΩ, 10kΩ 
6. Bread Board – 1 piece. 
7. Multi-meter  

 

CIRCUIT DIAGRAM: 
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PROCEDURES: 
 

1. Connect the circuit according to the above circuit diagram. 
2. Set the AC-GND-DC of CH1 in the GND position and align the trace with 

horizontal central line and then set to AC position. 
3. Now apply sine wave of 1 kHz from signal generator to CH1 and adjust its 

magnitude to 4V (p-p) by varying the attenuator knob of the signal generator. 
4. If the signal is not still just slowly vary the ‘level’ knob to make it still. 
5. Now disconnect the signal from CH1 and apply to terminals between 1 and 0. 
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OSCILLOSCOPE OPERATION 

 
6. Don’t change the attenuator knob throughout the experiment. 
7. Now connect the oscilloscope probes across 1 kΩ resistor to CH1 and across 10 

kΩ resistors to CH2 according to circuit diagram.     
8. Push CH2 INV button. 

 

 

1. Single channel operation: 
 

a) Set the AC-GND-DC of both channels in the GND position and align 
the trace with horizontal central line and then set to AC position. 

b) Adjust the FOCUS control so that the trace image appears sharply. 
c) Set the VOLTS/DIV switch at 1 V and TIME/DIV switch at 0.5 ms 

position so that signal waveform is displayed clearly. 
d) Adjust vertical POSITION and horizontal POSITION controls in 

appropriate position so that the displayed waveform is aligned with the 
graticule and voltage (p-p) and period (T) can be read conveniently. 

e) Set the Vert mode to CH1 and measure the p-p voltage across 1 kΩ 
resistor. Find the rms value of the signal from the following diagram: 

        Vrms =Vmeasured (p-p)/(2*√2) volt. 
f) Measure the voltage across 1 kΩ resistor by multimeter and compare 

with   the measured value. 
g) Set the Vert mode to CH2 and repeat procedure (e). 
h) Change the signal frequency to 100Hz, 10 kHz and observe the 

waveform. 
 
2. Dual-channel operation: 
 

a) Set the Vert mode switch to DUAL state so that both channels are 
displayed simultaneously. To display each channel separately change 
the vertical POSITION control of both channel to convenient position.  

b) When ALT/CHOP switch is released (ALT mode) signals respectively 
to CH1 and CH2 appear on screen alternately. 

c) When ALT/CHOP switch is pushed (CHOP mode) signals respectively 
to CH1 and CH2 are switched at 250 kHz. 

 
3. ADD operation: 
 

a) When Vert mode switch is at ADD position then the displayed signal is 
the algebraic sum of CH1 and CH2.if the CH2 INV switch is pushed 
then displayed signal is the difference of CH1 and CH2. 

b) Observe the waveform for both cases and draw. 
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OSCILLOSCOPE OPERATION 

 
 
4. Frequency measurement: 
 

a) The frequency of any waveform can be measured by adjusting the 
TIME/DIV control knob of oscilloscope. Adjust the TIME/DIV control 
knob to position 0.5 ms to observe the waveform. 

b) Now measure the frequency of the wave using the following formula: 
        1 large square or 5 small squares = t sec, here t = 0.5 ms     
        # of small squares required to represent a full cycle of wave =n sec   
                    Where, n may have fraction value.    
                     Time period, T = (n/5) × t s 
     Frequency, f = 1/T Hz 
 

                  

            16 small

            squares

     T

  t

 
 

     Now compare this value with the main signal frequency. 
c) Now vary the TIME/DIV control knob to different position and repeat 

(b). 
 
5. Sweep Magnification: 
 

a) Set the TIME/DIV switch at 0.5 ms and VOLTS/DIV at 1 V. Set AC-
GND-DC position at GND position and align the trace with horizontal 
central line. 

b) Set the Vert mode at CH1 and AC-GND-DC at AC and then push x 10 
MAG button. 

c) The displayed waveform will be expanded 10 times to the right and left 
with the centre of the screen as the centre of expansion. 

 
6. X-Y operation: 

 
a) Set the TIME/DIV switch at X-Y position. Now CH1 acts as X-axis 

input and CH2 as Y-axis input. 
b) X-Y positions are adjusted by horizontal position and CH2 vertical 

position control respectively. 
c) Adjusted the amount of vertical Y-axis with CH2 VOLTS/DIV controls. 
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OSCILLOSCOPE OPERATION 

 
d) Adjust the amount of horizontal X-axis with CH1 VOLTS/DIV 

controls. 
e) Observe the waveforms and draw. 

 
7. To display two input signals still on oscilloscope: 
 

a) Apply 2v (p-p), 1 kHz ac signal (sine wave) from signal generator-1 to 
CH1 of oscilloscope. 

b) Set VOLT/DIV of CH1 to 1 V and TIME/DIV to convenient position to 
observe the wave shape clearly. 

c) Repeat (1) from signal generator-2 to CH2 of oscilloscope. 
d) Set VOLT/DIV of CH2 to 0.5 v. 
e) Now set the Vert mode to DUAL position and observe the wave 

shapes.  
f) Note two waves that were displayed individually still are not still now. 
g) Set the SOURCE to CH1 and then CH2 position and observe what 

happens. 
h) Push the TRIG. ALT button and observe the wave shapes. 

 
Note: 

1) Don’t put any sort of electrical equipments (such as signal 
generator, dc supply etc.) on the top of the oscilloscope. 

2) Place the oscilloscope away from any magnetic field (as far as 
possible) 

3) If the GND horizontal line deviates significant amount then 
adjust it by rotating the position of oscilloscope. 

4) Always check the 10x switch of probe according to your 
measurement. 

5) Always avoid common grounding resulting from improper 
connection of knobs in the circuit. 

 

COMMON MISTAKES USING OSCILLOSCOPE:  
 

1) Changing the calibration knob during experiment. 
2) Changing the SWP.VAR knob during experiment. 
3) Improper 10x max for probe. 
4) Improper 10x max for frequency. 
5) Ground level adjustment during measurement. 

 
   
   


